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Chapter 2 : Introduction
TradePoint
TradePoint is a one stop solution for technical market analysis with the help of its key elements and
unique features.
TradePoint helps user to understand and have better analysis for prices prevailing currently in the market
and trade accordingly with the help of various charts plotting techniques.
Also, it provides user with the EOD data for trades on CASH and MCX which are known as EOD scanners
and real-time Scanners used for FNO- Future and Options.
Allows user choose the default indicator and patterns that will be captured and featured by default in any
chart.
To name a few USP’s of TradePoint are its Noiseless charts which includes ‘RENKO’, ‘Point n Figure’, ‘Line
Break’ and ‘Heikin-Ashi’ charts.
Some keys Tradepoint techniques which standout are Relative strength, Live Scanners, Smart Scanners.
TradePoint dishes outstanding features such as Indicators, Scanning, Matrix, Breath, Back testing and
many more.
All user defined and predefined systems are available for Real time Scanning.
TradePoint helps in Real time scanners where you can run the scanners on selected time interval on any
type of chart indicator or pattern or combination of both. All predefined and user defined systems are for
real time scanning.
Provides user preference feature to customize the look and feel for various charts in term of their
background colour and font.
It enables to check the multiple Stock performance and with multiline charts.
TradePoint helps to Exports charts in.CSV files.
Links: Videos on TradePoint.
https://insight.definedge.com/course/index.php?categoryid=29
https://insight.definedge.com
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Chapter 3 : System Infrastructure:
1. Software:
.Net Framework 4.5 is mandatory for the application to be run on your system.
Kindly click on the link: https://www.microsoft.com/en-in/download/details.aspx?id=30653
2. System Requirements:
Windows XP, Windows Vista, Windows 2007, Windows 8, Windows 8.1 and above
3. Hardware:
Minimum Required: Core 4 Processor, 8 GB RAM, 10 GB Disk space.
Supported Architecture: X64 and X86
4. Network Protocol:
TCP protocol is used for data integration and Winsock proxy server is mandatory to be configured for TCP
communication
http(s)://app.definedge.com(port 80,443)
http(s):data.definedge.com(port,443)
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Chapter 4 : Getting Started
Installation Steps:
1.

Click on the download button shown on Definedge site

2.

Once clicked on download, the TradePoint zip folder will be downloaded on to your system
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3.

Go to TradePoint. Zip folder and extract all its files to the desired location. Click on the TradePoint
application file and open the application

4. User will be guided to extract the required files so select the required destination and proceed
5.

Once completed you will see the actual TradePoint application file denoted by its symbol

6. Right click on it and run the application
* Note: Please do not locate your TradePoint downloaded file into the download folders of your systems.
Locate the file either on C: or D: drive folder for smooth operations.
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7.

Before TradePoint applications launches you will get the Proxy settings dialog window and ‘No Proxy’
should be selected until it is required Click ‘OK’:

8. When application is downloaded for the first time you will get the registration window for
authenticating your access. Fill in all the mandatary fields, tick on for the terms and conditions check
box and then click ‘Register’
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9. Upon successful registration a unique customer id is generated then click ‘OK’ button and an
activation link is sent on your mail id which you have provided while filling up the registration form.
Click on the link to “activate the 7-calenders day free trial for full version of TradePoint application”.

10. Now when you open TradePoint application, you will get the dialog box where you have to download
the Historical data for NSE followed by MCX markets
Note: As it may take few minutes please do not interrupt the process by clicking on Cancel button.
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After completion of the above process Tradepoint is ready for use now.
Go to the folder where you have located your TradePoint application and then right on it and then sent
to desktop to create shortcut for the application which will ease for use.
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Chapter 5 : Session handling through File option
1.

TradePoint Splash Screen and recommended actions:
When you click on TradePoint application TradePoint Splash screen will be displayed.
Followed by a download dialogue box which will require you to download the EOD Data for NSE and
MCX markets.

For every new user need to first got to Options>Manage Data> Data Registers and then download
Historical data for EOD data which gives the proper updates in trades on CASH and MCX.

Note: NSE data gets updated every day at 6:30pm and MCX data gets updated next day at 8:00 pm.
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2.

File:

This is the first option of the menu located on the top left corner of the application. When you click on it,
the user can access the following options:

How it works:
Open Session:


An existing session which has been used or preferred by the user can be opened by selecting this
option under the File menu



Click ‘Open Session’. A dialogue box will be displayed requesting the location of the session file. The
session files will have ‘.tps’ as its extension



Select the file and click on ‘Open’



The session will be displayed on screen and user can have the charts visuals like displayed below
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Save Session:


The user can save an ongoing session by selecting this feature under the ‘File’ menu. The saved session
can be used for reference later whenever the user needs it again without disturbing the preferred
pattern and choices



E.g.: User has to click on ‘Chart’ menu option and select the required type of chart. Select market and
choose the scrip then click on ‘OK’ button



Then the Selected Chart pattern for that required market and scrip get displayed.
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Now go to ‘File’ and Select ‘Save Session’. A dialogue box requesting user to choose the destination
will be displayed



Select destination drive/folder and click on OK



The session will be saved in .tps extension at the chosen destination

Print:


This will open up Print dialogue box which you need to fill for getting the session prints

Page Setup:


This option allows users to adjust the orientation of the session print
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Print Preview:


This option shows users that how actual the session print will be displayed on page

Close:


This option is used to close the current session on which the user has his/her cursor pointing on
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Close All:


Close all option helps the user to closes multiple chart’s on-going session which user is viewing and
not the Scanners.

Exit:


This option is simply exits you from the TradePoint application
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Chapter 6 : Charts in TradePoint
Types of Charts :
These are 5 types of crucial charts and shortcuts to access them:

Once you select any chart additional two options are enabled ‘Tools’ and ‘Projection’ menu bar:
Tools : This feature helps us plot different types of tools on charts
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Projection : This feature helps in plotting projection from single or multiple candlestick patterns.

Let us look at each chart:


OHLC Chart: Ctrl+O
This chart shows the open, high, low, and close price and can be illustrate price movement adjusted
to any timeframe. Based on Candlestick method.
OHLC strategy in intraday trading is the technique that is used to filter out scrips that have open=high
or open=low. OHLC charts show more information than line charts.

Reference Link: https://insight.definedge.com
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OHLC Chart (Straddle/Strangle): Ctrl+O
This chart is shown with the combination of any markets (NSE/MCX/FNO) plus when required ‘PUT’
and ‘Call’ are selected

Reference Link: https://insight.definedge.com


P&F Chart: Ctrl+P
This is the oldest chart method. By selection of market and scrips you can load P&F Charts.
These are one dimensional charts and where only price is being considered and they move vertically
in columns.
You need to populate details in P&F chart dialogue box for the chart to be displayed.

Reference Link:
https://insight.definedge.com/course/index.php?categoryid=1
https://insight.definedge.com

- 18 -



P&F (RS/Straddle/Strangle) Charts:
This is an extended version of P&F chart where you can analyse on the basis of Relative Strength
indicator or by Straddle/Strangle strategy.

Reference Link: https://insight.definedge.com/course/index.php?categoryid=1


LB Chart: Ctrl+L
Line break charts is to filter out market noise and give a clear indication of the current trend and trend
reversals. Line break charts helps to determine the current trend of market price movement that
consolidates, and a trend reversal can be just as difficult.
It is made up of a series of vertical blocks called lines that use closing prices to indicate market
direction.
You need to populate details for Market, scrip, lines and options in LB chart dialogue box for the chart
to be displayed.

Reference Link:
https://www.definedge.com/line-break-chart-tools
https://www.definedge.com/line-break-charts-by-prashant-shah
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LB (RS/Straddle/Strangle) Charts:
This is an extended version of Line Break chart where you can analyse on the basis of Relative
Strength indicator or by Straddle/Strangle strategy.



Renko Chart: Ctrl+R



This chart is originated from Japan. Simplicity and objectivity are major advantages and synonym used
for Renko Chart. Renko charts are connected by drawing both the prices by drawing a box known as
brick. Renko charts helps in removing the noise from the data by defining the ‘brick value’.



You need to populate details for Market, scrip, brick size and options in Renko chart dialogue box for
the chart to be displayed.

Reference Link: https://insight.definedge.com/course/index.php?categoryid=12
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Renko (RS/Straddle/Strangle) Charts:
This is an extended version of Renko chart where you can analyse on the basis of Relative Strength
indicator or by Straddle/Strangle strategy.

Reference Link: https://insight.definedge.com/course/index.php?categoryid=12


Heikin-Ashi Chart: Ctrl+H
Heikin-Ashi chart is old Japanese charting method and developed by Munehisa Honma who was
Japanese rice trader. This chart also considers four prices OHLC of market. These prices are calculated
on Candlestick price data and in sequence stated as OCHL (OPEN-CLOSE-HIGH-LOW).
You need to populate details for Market and scrip in Heikin-Ashi chart dialogue box for the chart to be
displayed. Also you can analyse more by ticking in the ‘Ztrend’ checkbox.

Reference Link:
https://insight.definedge.com/mod/page/view.php?id=259
https://insight.definedge.com
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PCR Chart:
PCR (PUT/CALL ratio) is a popular derivative indicator, specific purpose is to help traders gauge the
overall sentiments of the market. The ratio of ‘PUT’ trading volume is divided by the ‘CALL’ trading
volume. When the majority thinks the market is going to move a certain direction, it usually does the
opposite.
Hence for the traders, the ‘Put Call Ratio’ can be used to determine when the crowd is getting either
too bullish or too bearish. Hence, option traders should keep a close eye on this ratio to take contracalls on the market.
PCR charts up to six instruments can be viewed simultaneously using this function.
Reference Link: https://www.definedge.com/pcr_chart

1.

Snakes (Multiple Straddle /Strangle):
You need to enter the details for Market (NSE, FNO, MCX), scrip for Group 1 and Group 2 then click ‘OK’
button in dialogue box for the chart to be displayed.

Chart Output:
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2. Multiple Ratio Performance:
You need to select for Market (NSE, FNO, MCX) then scrip for Group 1 and Group 2, select the date
range and click ‘OK’ button in dialogue box for the chart to be displayed.

Chart Output:

Reference Link: https://www.definedge.com/multiple-ratio-performance

- 23 -

3. Multiple OpenInterest:
You need to select FNO market then scrip for Group 1 and Group 2, select the date range and click
‘OK’ button in dialogue box for the chart to be displayed.

Chart Output:

Reference Link: https://www.definedge.com/multiple-open-interest
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Ratio/Spread/Sum Chart:
4. Ratio Method:
Traders use a ratio strategy when they believe the price of the underlying asset won't move much,
although depending on the type of ratio spread trade used the trader may be slightly bullish or bearish.
Market value ratios are used to evaluate the current share price of a publicly-held company's stock.

5. Spread Method:
Spread chart is that it is a comparison between a financial instrument (such as a stock) and an
additional variable (such as another financial instrument or a numerical value)
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6. Sum Method:

All the three methods share the common dialogue box for entering the data. Select for Market (NSE,
FNO, MCX) then scrip1 and Scrip 2 now ‘as per the method required choose radio button’
and click ‘OK’ button in dialogue box for the chart to be displayed.



Chart Comparison: Ctrl+C
This simply lets you analyse your stocks behaviour in terms of price. You need to select Market (NSE,
FNO, MCX) then scrip1 and Scrip 2 for charts to be compared against and click ‘OK’ button in dialogue
box for the chart to be displayed.
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Weighted Average Index:
The weighted average market capitalization refers to a type of stock market index construction that
is based on the market capitalization of the index's constituent stock.
You need to select Market (NSE, FNO, and MCX), select Group from the dropdown. Select date range
for taking out the weighted average and then click ‘OK’ button in dialogue box for the chart to be
displayed.

Market Profile:
Market Profile is an intra-day charting technique which revealed a new way of looking at markets, and
paved the way for more rational and relevant market analyses.
It’s a graphical representation that combines price and time information in the form of a distribution.
A Market Profile is used to determine elapsed time, number of ticks and volumes traded at specific
prices, or over a price interval, over a given period.
You need enter details by selecting FNO market, scrip, TPO, duration for market hours, Time blocked,
View for charts to be compared against and click ‘OK’ button in dialogue box for the chart to be
displayed.
Chart when Absolute view is selected.

Chart when ‘%’view is selected.
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Multiple Stock Performance:
Stock performance is the measurement of a stock's ability to increase or decrease the wealth of its
shareholders. Performance is typically measured by its fluctuation in price. When the stock price
increases, the stock shows good performance. Conversely, a decrease in price is a poor performance.
This enables you to compare between maximum of 10 stocks.
You need enter details by selecting NSE, MCX market, scrip names for the required stocks, date range
and then click ‘OK’ button in dialogue box for the chart to be displayed.

Reference Link: https://www.definedge.com/multiple-stock-performance
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Multi Leg-Line:
Basically, this method refers to any trade that involves two or more options. Multi-leg options orders
are generally used to capture profits when pricing volatility is expected but direction is unclear.
You need enter details by selecting FNO market, scrip names for the required stocks, choose between
long or short radio button and then click ‘OK’ button in dialogue box for the chart to be displayed.

Reference Link: https://www.definedge.com/multilegchart
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Chapter 7 : Elements commonly used by Charts
When TradePoint application is launched you get this following ‘chart controller’ and ‘information’ which
are static.

Once you load the chart by selecting the market and choosing the Scrip, the view of the charts can be
customized in terms of timeframe/pattern/zoom in/zoom out/Grid with the help of ‘View’ option which
gets enable in the Menu Bar.
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Further you can integrate ‘Add Study’ option into the chart for deeper analysis by selecting between
‘Indicators/Patterns’ radio button and options listed below them.

If you wish to remove these elements included from ‘Add Study‘, simply go the ‘Cancel’ button which is
on the top left corner in the chart screen. Then a dialogue box displays where you need to checkbox the
items you want to remove and then click ‘OK’.
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Chapter 8 : Scanners & their types
Scanners are essential for finding the right trading opportunities quickly. TradePoint rules out this
difficulty and provides solutions to spot the perfect trade chance by dishing out these three major
categories of scanners.
1. EOD Scanners
2. Real time Scanners
3. Smart Scanners
These scanners display the data, trend, information in different forms of charts which the user can
choose as per his requirements.
The main interesting feature of EOD and REAL TIME scanners is that you can run multiple scanners
and integrate multiple strategies / charts / timeframes with them simultaneously.
In TradePoint EOD Scanners supports ‘12 types of EOD scanners’ let’s take a look:
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EOD Scanners:
EOD-OHLC Scanner:
A candlestick pattern dialogue box gets displayed and you need to fill in the required details for the
chart to load.
Select Market: NSE/ MCX/ FNO.
Select scrip group.
Select Pattern Type: Pre-defined pattern/ User defined system.
Select Scanner Type.
Select Time Frame: Daily/ Weekly/ Monthly/ Quarterly.
Click on ‘Scan’ button to view scan results.
Then result gets displayed along with date and LCP

.
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Click on the ‘View Report’ button to view scan results.
Click on the ‘Export Report’ button to ‘Export’ scan results in ‘.CSV format’.

By clicking on ‘Save Group’ button’ you get ‘Input’ pop up window where you can enter group name in
which you want to save the results.
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Hence when you double click on Scrip name the chart will be displayed.

EOD – POINT & FIGURE SCANNER:
A Point &Figure dialogue box gets displayed and you need to fill in the required details for the chart to
load.
Select Market: NSE/ MCX/ FNO.
Select scrip group.
Select Pattern Type: Pre-defined pattern/ User defined system.
Select Scanner Type.
Select Box size & Reversal Box size.
Select Signal type: Running/ Fresh.
Select Price type: Close only/ High and Low.
Click on ‘Scan’ button to view scan results.

- 35 -

Then results gets displayed along with date and LCP.

Click on the ‘View Report’ button to view scan results.
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Click on the ‘Export Report’ button to ‘Export’ scan results in ‘.CSV format’.

By clicking on ‘Save Group’ button’ you get ‘Input’ pop up window where you can enter group name in
which you want to save the results.

Hence when you double click on Scrip name the chart will be displayed.
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EOD DT% Breadth Scanner:
A DT% dialogue box gets displayed and you need to fill in the required details for the chart to load.
Select Market: NSE/ MCX/ FNO.
Select: Box Value and Reversal Value.
Click on “Ok” button to get the results:
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Results: “Breadth Value” gets displayed along with remark. Then Click on the ‘Export Report’ button to
‘Export’ scan results in ‘.CSV format’.

Reference Link for other EDO – charts:
https://www.definedge.com/scanners
Realtime Scanner:
In TradePoint, Realtime Scanners supports ‘7 types’ Realtime Scanners.
Let us take a look:

Realtime OHLC Scanner:
A Realtime candlestick pattern dialogue box gets displayed and you need to fill in the required details for
the chart to load.
Select scrip group.
Select Scanner Type
Select Frequency
Algo setting is available if required.
User gets sound alert for the upcoming results, if the ‘Sound’ check box is checked.
User gets tick level scanner
User gets tick level scanner results, if the ‘Tick level’ check box is checked.
Click on ‘Scan’ button to view scan results:
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When ‘Scan’ is clicked required results gets displayed along with date and LCP.
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When you double click on scrip name the chart will displayed.

Reference Links for other Realtime – charts:
https://www.definedge.com/how-to-use-rt-scanners
Smart Scanners:
In TradePoint, Realtime Scanners supports ‘11 types’ of Smart Scanners let’s take a look:

Smart P&F Follow through Scanner:
Select Market: NSE/ MCX/ FNO.
Select stock group.
Select: Box Size and Reversal Box Size.
Price: Close Only/ High and Low.
Signal Type: Running/ Fresh.
Click on ‘Scan’ button to view scan results:
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Results: It will show the result with T1 (VC-1), T2 (VC-2) and stop loss along with its pattern type.
By clicking on ‘Save Group’ button’ you get ‘Input’ pop up window where you can enter group name in
which you want to save the results.

Reference Links for other Smart Scanner – charts:
https://www.definedge.com/how-to-use-smart-scanners
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Chapter 9 : Back Testing
System Builder:
It is used to define the system which can be created and used for ‘BackTesting’ w.r.t the required
backtesting Methods.
A trading system builder consists of a concise set of objective rules based on measurable factors that are
used to signal when to initiate buy and sell trades on a market.
Systems Builder is a significant component in TradePoint. You can create new systems from ‘systems lists’
and ‘strategies’: w.r.t charts using the builder.
Let us see how it works:

System builder window will get opened and then select chart type: OHLC/ P&F/ LB/ RENKO/ HEIKIN-ASHI/
RATIO.
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Click on ‘Add’ to create a new system.

By clicking on ‘Add’ button we get ‘Add Study’ pop up window where we can select the inputs for
condition.
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Select ‘Indicator’ or ‘Pattern’ using radio button and its name from drop down list.

User can select the dynamic condition from drop down list or change the parameters as required.
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To add second condition again click on ‘Add’ and follow same procedure.

Enter appropriate expression and system builder name then Click on ‘Ok’.

Click on ‘Save’ to save the system.
Reference Links for System Builder: https://www.definedge.com/pf-system-builder
BackTesting:
BackTesting is a key feature which TradePoint provides its users. BackTesting a trading strategy is the
process of testing a trading hypothesis/strategy on prior time periods.
BackTesting allows a trader to simulate a trading strategy using historical data to generate results and
analyse risk and profitability before risking any actual capital.
Mandatory requirements for backtesting requires a minimum of two systems one is for entry and exit.
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TradePoint provides ‘7 types’ of BackTesting. Let’s have a look.

BackTesting-P&F BackTesting:
When P&F BackTesting is selected its window is opened. You need to enter the required data for the
results to be displayed.
Select Group/ Scrip option and its name accordingly.
Select Market: NSE/ MCX
Select Frequency.
Select ‘Period from’ &’ Period To’.
Select conditions for ‘Long Entry’ and ‘Long Exit’.
Click on ‘Scan’ button to get the results:
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Result gets displayed as shown when clicked on ‘Scan’ button.

Click on the ‘symbol name’ to get the detail report.
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‘BackTesting Report’ gets displayed as shown.

Summary report is available at the end of the report as shown.
Click on the ‘Export’ button to save scan results. CSV format is supported for Export.

Reference Links for BackTesting related charts:
https://www.definedge.com/how-to-design-your-own-system
https://www.definedge.com/how-to-backtest-in-tradepoint
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Chapter 10 : Breadth
Market Breadth is very intuitive method of judging the markets. Breadth indicator don’t typically provide
trade signals on their own, but rather provide an overall picture of the health on an index to traders and
investors.
Breath indicators are the mathematical formulas that measure the number of advancing and declining
stocks, and/or their volume, to calculate the participation in a stock index’s price movements.
TradePoint facilitates with ‘5 types’ of Breadth indicators.
1. P&F X Percent.
2. P&F DT Percent
3. LB Bullish Line %
4. Renko Bullish Brick %
5. Advance-Decline Ratio
So, let us take a look at the P&F DT Percent indicator.

When clicked on P&F DT Percent is clicked the following window gets opened where you need to enter
the details for further actions to actions.
Select Market: NSE/ MCX/ FNO.
Select stock group.
Select: Box Value and Reversal Value.
Select: From Date and To Date.
Click on ‘Ok’ button to get results:
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Results: The ‘P&F DT% graph’ will get display as shown for the selected period.

Reference Links for more Breadth related chart indicators:
https://www.definedge.com/how-to-open-breadth-indicator-chart
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Chapter 11 : Matrix
Matrix along with its indicators is amongst one of the USP features of TradePoint. Matrix displays the
session’s trading range
This involves estimating what the price of a bond should be looking at similar debt issues and then
applying algorithms and formulas to tease out a reasonable value.
It lets you see market activity at a glance and instantly place trades at the price level you want. A quick
look can help you decide when to pull the trigger on a stock, futures or options trade.
TradePoint facilitates with ‘19 types’ of Matrix table.
Let us take a look:

All Chart Matrix:
Select Market: NSE/ MCX/ FNO
Select stock group:
Select: Box size values for P&F Chart
Brick size value for Renko Chart.
Click on ‘Scan’ button to view scan results:
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‘All Chart Matrix’ gets displayed as shown.

You can click on ‘Total Score’ to sort the column.
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Click on the ‘Export’ button to save scan results. CSV format is supported for Export.

P&F Matrix:
Select Market: NSE/ MCX/ FNO
Select stock group.
Select: -Box Size (%)
-Weightage
-Setup Box Size (%)
-Reversal Box Size
-Price: Close Only/High and Low
-‘Performance Trend’ and ‘Ranking Trend’ are read only fields.
-Click on ‘Scan’ button to view scan results:
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‘P&F Matrix’ gets displayed as shown.

You can click on ‘Performance Score’ or ‘Ranking Score’ to sort the respective columns.
Click on the ‘Export’ button to save scan results. CSV format is supported for Export.
You can save the result to a group by entering score value and other required fields. By clicking on ‘save
group’ we get ‘Input’ pop up window where we can enter group name.
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The chart will be open on double click on scrip name.

Matrix- RS Matrix:
Select Market: NSE/ MCX/ FNO
Select stock group.
Select Scrip2.
Select: -Box Size (%)
-Weightage
-Setup Box Size (%)
-Reversal Box Size
-Price: Close Only/High and Low
-‘Performance Trend’ and ‘Ranking Trend’ are read only fields.
Click on ‘Scan’ button to view scan results:
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Then the RS Matrix gets displayed. RX Matrix is similar to ‘P&F Matrix’ in terms of:
-Sorting techniques for ‘Performance Score’ or ‘Ranking Score’.
-Saving the result to group
-Format for Scan results
You can follow the same steps for the above-mentioned functionality. Hence the chart will be open on
double click on scrip name.

Matrix- OHLC System Matrix:
Select Market: NSE/ MCX/ FNO
Select stock group.
Select: - Scanner Type 1
- Scanner Type 2
Select the saved condition from system builder
- Scanner Type 3
Select time frame for each scanner type: Daily/ Weekly/ Monthly.
‘Qualified%’ and ‘Non-Qualified%’ are read only fields.
Click on ‘Scan’ button to view scan results.
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OHLC System Matrix gets displayed as shown. You can click on ‘Score’ to sort the respective column.

System Matrix is similar to ‘P&F Matrix’ in terms of:
-Saving the result to group
-Format for Scan results
You can follow the same steps for the above-mentioned functionality. Hence the chart will be open on
double click on scrip name.
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Matrix: Sector Matrix.
Select: -Box Size (%)
-Weightage
-X Percent and DT Percent
- Reversal Box Size-Price: Close Only/High and Low
Click on ‘Scan’ button to view scan results:

Sector Matrix gets displayed as shown.

You can click on ‘Total Ranking‘ to sort the column. Click on the ‘Export’ button to save scan results. CSV
format is supported for Export.
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The chart will be open on double click on scrip name.

Matrix: Ultimate P&F – RS Matrix
Select Market: NSE/ MCX/ FNO
Select stock group.
Select.
-Box Size (%)
-Reversal Box Size
-Price: Close Only/High and Low
Click on ‘Scan’ button to view scan results.

Ultimate P&F – RS Matrix gets displayed as shown.
You can click on ‘Total’ to sort the respective column.
Click on the ‘Export’ button to save scan results. CSV format is supported for Export.
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The respective chart will be open on double click on scrip name.

Reference Links for other Matrix:
https://www.definedge.com/matrix
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Chapter 12 : Table
Table, in TradePoint helps to gather information can help you select promising investment opportunities
and monitor your stocks’ performance. Each column in the chart gives you some clues about the current
state of affairs for a particular company to help you make smart investment decisions.
Blessed to have these features which you only get in TradePoint such as ‘Open interest analysis’,
‘Performance Table’, ‘Watchlist EOD’, ‘Indicator Value’, ‘Relative Strength report’, ‘P&F Column Info’, ‘OHLC
Bar’.
The tables consist of following parts:
-Pivot table
-Camarilla table
-Fraction table
-Fibonacci table
-Open interest analysis
-Performance tale
-Watchlist EOD
-Indicator Value
-Relative Strength Report
-P&F column info
-OHLC Bar info

Select market, select scrip group, timeframe and bar value and scan for the result.
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You will get Support and resistance level as shown below.

Then when you click on ‘View Report’ the table report will be displayed.

Reference Links for Tables:
https://www.definedge.com/table
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Chapter 13 : Journal
Journal, is a detailed record of all the transactions done by a business.
A journal is of utmost important to testing different strategies and finding which trading plans work for
individual traders.
Also help traders pinpoint strengths and weaknesses in a trading style.
In TradePoint there ‘4 types’ of Journals available:
-Trading journal
-Quantity checker
-Position tracker
-Pair trade calculator

Let’s look at the ‘Quantity Checker’ Journal:
-Select max risk per trade
-Select quantity
-Select entry level
-Select exit level
-Select ok
-The values of tracking quality and as per plan will be obtained.
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Reference Links for more Journals:
https://www.definedge.com/how-to-use-journal
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Chapter 14 : Option
The options part consists of following parts
-Indicator pattern preference
-Manage data
-User preference
-Download
-Market watch – real time
-Projection setting
-Messages
-Chart switch
-Log level

Let us look at the navigation:
-Select the type of chart
-Add indicator/ pattern
-Save the list
-The indicator and pattern can be deleted by the delete button
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The saved indicator & pattern will be applied default on every chart opened.
Reference Links for other listed features in Option:
https://insight.definedge.com/course/index.php?categoryid=36
https://insight.definedge.com/course/index.php?categoryid=42
https://www.definedge.com/rtmaster
https://www.definedge.com/split-bonus
https://www.definedge.com/symbol-manager
https://www.definedge.com/Projection-setting
https://www.definedge.com/how-to-see-messages
https://www.definedge.com/how-to-plot-obv-chart
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Chapter 15 : Windows
Windows in TradePoint helps user to set the appearance of his charts as per their preferences.
There are ‘3 types’ of view preferences which the user can select.
Window:
-The Vertical
-The Horizontal
-Cascade

Window: The Vertical:
On selection this option, the charts will be oriented in vertical view.

Window: The Horizontal:
On selection this option, the charts will be oriented in horizontal view.
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Window: Cascade:
On selection this option, the charts will be oriented in cascading style.
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Chapter 16 : Help
Help: consists of two sub options >’About’ and ‘Refresh’.
About: Information about the TradePoint copyright will be displayed along with TradePoint customer Id,
Customer Name and Valid till date.

Refresh: When you click ‘OK’ your TradePoint license gets downloaded and then you need to restart your
application.

Helpful Links:
https://www.definedge.com/how-to-apply-tools
https://www.definedge.com/user-preference
https://www.definedge.com/how-to-plot-patterns-on-chart
https://www.definedge.com/how-to-import-files-in-tradepoint
https://www.definedge.com/indicatorpattern-preference
https://www.definedge.com/how-to-edit-candle-data
https://www.definedge.com/how-to-find-group
https://www.definedge.com/edelweiss-report-trade
https://www.definedge.com/how-to-refresh-license
https://www.definedge.com/how-to-resolve-issue-if-isp-fails-to-locate-ip-add
https://www.definedge.com/how-to-refresh-license
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